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PP-0001 --- November 2013

POST SEASON PROGRAM EVALUATION PROCESS

Purpose: The purpose of the Post Season Evaluation is to obtain feedback from players, parents and coaches
necessary for continuous improvement in the program. For example, the feedback is used when rewriting rules,
selecting coaches, buying new equipment, etc. The surveys are confidential and used as a tool to improve the player
experience in VAA and to track satisfaction in the various sports.

The following identifies the individuals involved in the evaluation process.
a. Board of Directors

b. Sports Liaison

c. Sports Commissioner

d. Coaches

e. Parents/Players

The responsibilities of each are as follows:
a. Board of Directors:
i. Develop an online evaluation form, which can be used for all sports offered by VAA, and ensure that access is
available through the website as appropriate.

1. The bulk of the survey will be common across all leagues so that the VAA board can compare responses
between leagues and across the entire VAA organization.

2. Leagues may request additional league-specific questions be added to the survey.
The VAA board has the responsibility to ensure the surveys do not become overly burdensome, and thus retains the
right to work with the leagues to control the overall length of the survey.
ii. Schedule time for a presentation of the feedback information by the sports liaison at a monthly Board of Directors
meeting. Presentations will generally be scheduled at the same meeting that the commissioner provides the post-
season recap.
iii. Establish policy when necessary to make improvements in the sports program as a result of feedback.

b. Sports Liaison:

1. Provide the applicable sports commissioner with instruction on how and when to access the survey for each player
registered for the sport and their parents.

1. The Sports Liaison will work with the VAA administration assistant to send email notices to league participants
near the end of the season. The email message will request participants complete an on-line survey and should
contain a link to the appropriate survey.



2. Leagues may develop supplemental plans to further encourage participants to complete surveys

ii. Compile all evaluations for the applicable sport.

iii. Review the completed evaluations and determine if any actions are required based on the feedback data.

iv. Make personal contact with those individuals requesting to be contacted by a board member.

v. Review the feedback information with the sports commissioner prior to the post-season recap.

vi. Document the feedback for a presentation to the Board of Directors as scheduled by the president of VAA -
collects, reviews, and prepares "sanitized" summaries of the surveys.

"Sanitized" means the removal of confidential information identifying either league personnel (e.g., coach) or the
player submitting the survey. The sanitized summaries are shared with the VAA board (and especially the VAA
liaisons to the sports), the commissioners, and other league personnel as deemed necessary by the commissioners.
Should a survey describe any problem that requires either VAA board or league action, that situation will be handled
on an individual basis including divulging confidential information as needed.

vii. Retain the evaluations for community sports in for a period of three years. The Sports

Commissioner and Sports Liaison shall determine retention of evaluation forms for traveling sports.

viii. Ensure the confidentiality of individuals completing the evaluation forms.

c. Sports Commissioner:

i. Provide each coach with instructions for online completion for each parent and player on their team, including
schedule and deadlines.

ii. Ensure the Confidentiality of individuals completing the evaluation forms.

iii. Get feedback from the sports liaison. Commissioners have the permission and ability to see the unedited survey
results, though due to privacy concerns, only commissioners (and the Board) will be given access to unedited survey
results. Accessing the unedited survey results is an explicit agreement to not share any confidential information
unless necessary to take corrective actions. Divulging confidential information is considered an extreme step and
should be avoided if at all possible.

iv. Provide feedback to the coaches.

v. Work with the sports liaison, coaches, parents and Board of Directors to improve the program based on the
feedback..

vi. Use the feedback information during the coach selection process.

d. Coaches:
1. Distribute instructions for online completion to each player and parent assigned to their team.
ii. Encourage both players and parents to complete the form.

e. Players and Parents:
i. Complete online survey as requested. Parents and players are asked to make comments on coaches, assistant
coaches and the overall program.

The following information pertains to the surveys.
i. The Survey for each sport will be open at the beginning of the season and stay open for 30 days following



the last regular season game or meet.
ii. The Survey will be conducted on Survey Monkey and there will be a link on the VAA website to access
the appropriate survey.



DRUG AND ALCOHOL POLICY

1. The Valley Athletic Association believes that all players/coaches participating in a
VAA youth activity should refrain from the use of alcohol and/or a controlled substance.

2. It shall be a violation of this policy for a player/coach participating in a VAA youth
activity to use a beverage containing alcohol or use or consume, have in possession, buy, sell or
give away any controlled substance.

3. Once a violation has been brought to the Boards attention and a decision has been made
by the VAA Board, the player/coach will be informed of their ineligibility in the VAA by a
written letter from the VAA Board of Directors.

a. First Violation:
Upon notification by the Board, the player/coach shall lose eligibility for the next two
consecutive games or two weeks of a sport season in which the player/coach is participating,
whichever is greater. No exception is permitted.

b. Second Violation:

The player/coach shall lose eligibility in the VAA for that sport season. No exception
is permitted.

¢. Accumulative Penalties:

Penalties shall be accumulative beginning with and continuing throughout the
players/coaches participation in the VAA.



PP-0003 --- March, 2011

TOBACCO POLICY

The Valley Athletic Association (VAA) does not condone the use of tobacco by players
under the legal tobacco age.

It shall be a violation of this policy for a player participating in a VAA activity to use
tobacco.

Once a violation has been brought to the Board’s attention, the player will be informed of
their ineligibility. Ineligibilities will be the same as for the Drug, Alcohol Policy (See
PP-0002).

The VAA asks that coaches, parents, visitors, volunteers, and others refrain from the use
of any tobacco during a VAA youth sport activity.

VAA uses the facilities of Independent School District 196. All VAA activities taking
place at any District facility must adhere to the District’s Tobacco-Free Environment
policy, series number 406.5AR, and VAA agrees to follow such policy when using
District facilities.

VAA uses the facilities of the City of Apple Valley and any other local City’s facilities.
All VAA activities taking place at any city owned facility must adhere to that City’s
Tobacco-Free Environment policy, and VAA agrees to follow such policy when using
these City facilities.

In any event, any person not adhering to the Tobacco Free policies will be asked to leave
the premises where they are at the time of the infraction.



PP-0004 --- June, 2012

COACH OF THE YEAR

Paul Bronson Memorial Coach of the Year Award

The Valley Athletic Association recognizes the importance of many volunteer hours and the

effort put in by numerous volunteers in the community. We appreciate everyone’s help in

making the VAA program a success and want to honor, annually, a coach in the Traveling

program and a coach in the Community program that exemplify the following characteristics:
- Respects everyone involved in the game

- Demonstrates good sportsmanship

- Concerned with the development of all the players and focuses on the ‘team’ aspect

- Positive Role Model

- Ability to improve the performance of the players on the team

- Listens to input from, and provides feedback to, the parents regarding a child’s progress
- Prepares for and conducts well-organized practices and games, involving all players

- Understands the rules of the sport

- Creates a fun and enjoyable experience for the players

- Follows the mission of the VAA

The VAA will accept nominations from any member of the VAA community (no self-
nominations). The attached nomination form can be submitted to the VAA Board. Nominations
must be received by October 15 to qualify for the current year’s award, which will be voted on
by the VAA Board of Directors and presented during the VAA Annual Meeting. Any late
submissions will qualify as a submittal for the following year’s award.

Background:

Paul Bronson coached VAA football and basketball beginning in 1997. He touched the lives of
many youths through his generous commitment and energy. Paul shared many of the same
values that are at the foundation of VAA. During his years of service in VAA, Paul
demonstrated respect for the kids he coached, received commendations from parents and
exemplified the true spirit of sportsmanship. With four kids of his own, Paul was always willing
to step forward and help with the VAA teams. Paul made an extraordinary impact, and had a
positive influence, on the kids he coached. Paul Bronson passed away on December 21, 2004.



PP-000S --- April, 1996

COACHES CODE OF ETHICS

All coaches are expected to sign the Coaches Code of Ethics at the beginning of each season. It is
the responsibilities of the sports commissioners to have the coaches of their sport read and sign
the statement as noted below.

I hereby pledge to live up to the VAA coaching guideline by following the listed Code of Ethics:

I will place the emotional and physical well being of my players ahead of any personal
desire to win.

I will remember to treat each player as an individual, remembering the large spread of
emotional and physical development for the same age group.

I will do my very best to provide a safe playing situation for my players.
I will do my best to organize practices that are fun and challenging for all my players.

I promise to review and practice the necessary first-aid principles needed to treat
injuries to my players.

I will lead, by example, in demonstrating fair play and sportsmanship to all my players.

I will ensure that I am knowledgeable in the rules of each sport that I coach, and that I
will teach these rules to my players.

I will use those coaching techniques appropriate for each of the skills that I teach.
I will remember that I am a youth coach, and that the game is for children and not adults.

I will demand a drug, alcohol and tobacco —free sports environment for my team and
agree to assist by refraining from their use at all games and practices.

COACH’S SIGNA'TURE DATE



PP-0006 --- June, 2012

SPORTSMANSHIP / BEHAVIOR GUIDELINES

All players, coaches, and spectators are expected to act responsibly and demonstrate sportsmanlike behavior at all
VAA games, practices and activities as defined in the coaches, parents, and players VAA Code of Ethics (PP 0005,
PP 0015, and PP 0019). A primary goal of VAA is to help our children grow and mature through participation in
sports. Learning to deal with winning and losing are an important part of a child’s development but wins and losses
cannot be allowed to override the most important goal. We want players to have fun, be able to improve, have a
positive experience and to learn to exhibit good sportsmanship.

Player Behavioral Concerns
If a player verbally or physically abuses a referee, coach, player or spectator OR demonstrates unsportsmanlike
behavior towards a referee, coach, player or spectator, the following will take place:

1) Referee will talk to the player’s coach. The coach will discuss with the player.

2) I1st Incident Report — Coach will meet with age group director/commissioner to discuss the
incident.

3) 2nd Incident Report - player is not allowed to participate in team activities until the player, the
player’s parents, and coach meet with the team’s age group director/ commissioner to discuss past
behavior and future involvement.

4) Incidents will be documented by the referee using the VAA Incident Report form (available on
the Association website). The referee will give the completed report to the referee coordinator
who will forward the report to the age group director/commissioner. The age group
director/commissioner will forward a copy to the VAA board liaison.

Note - depending on the severity of behavior, steps may be omitted.

Spectator Behavioral Concerns
If a spectator verbally or physically abuses a referee, coach, player or a spectator OR demonstrates unsportsmanlike
behavior towards a referee, coach, player or spectator, the following will take place:

1) Istincident - referee will stop the game and notify both coaches of the problem. Coach will either
issue a VAA Behavior Citation Card (see below) to spectator or inform the spectator that another
stoppage in play will result in he/she leaving the premises.

2) If inappropriate behavior continues, the referee will stop the game until the spectator leaves the
premises. If the spectator does not leave - the team he/she is supporting will forfeit the game.

3) Incidents will be documented by the coach of the team the spectator is supporting using the VAA
Incident Report form (available on the Association website). The coach will give the completed
report to the age group director/commissioner who will forward a copy to the VAA board liaison.

Note - depending on the severity of behavior, steps may be omitted.

Coach Behavioral Concerns
If a coach verbally or physically abuses a referee, coach, player or a spectator OR demonstrates unsportsmanlike
behavior towards a referee, coach, player or spectator, the following will take place:
1) Istincident report- age group director/commissioner will discuss behavior with the coach.
2) 2nd incident - coach will be suspended — See PP 0016 Suspension of Coaches Policy
3) Incidents will be documented by the referee using the VAA Incident Report form. The referee
will give the completed report to the referee coordinator who will forward the report to the age
group director/commissioner. The age group director/commissioner will forward a copy to the
VAA board liaison.
Note - depending on the severity of behavior, steps may be omitted.



* Anyone can submit a VAA Incident Report Form — available at www.valleyathletic.org
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WE WILL STOF THE GAME UNTIL YOU LEAVE THE PREMISES




PP-0007 --- March 2011

FUNDRAISING APPROVAL

All sports have the ability to do fundraising for their sport. On Community teams, all fundraising
monies go directly to support that particular sport. Traveling teams generally have both league
and individual team fundraising opportunities available.

A fundraising activity is one in which there is an organized effort to raise money for any
particular segment of any sport within VAA, by selling goods or services within the community.
A legitimate fundraising activity is one in which the fundraiser is approved by the Commissioner
of the sport and brought to the Board’s attention through the VAA Board Liaison for that sport
and/or the full Board of Directors.

It is up to each Commissioner to determine if a specific team or age group should raise money.
Fundraising should be used to raise funds for specific uses and done as a cooperative, either at a
team level, age group level or league level. The Commissioner shall have the right to determine
whether or not any team, group or age shall not be able to fundraise and/or the type of
fundraising that will be done.

All monies raised during a fundraising activity must be accounted for within the VAA Financial
System and recapped and given to the VAA Treasurer to be deposited into that sport’s account.
Fundraising needs to be accounted for in the Sports Budget proposal, which is then approved by
the Board.



PP-0008 --- September 4, 1996

TRAVELING COACH SELECTION PROCESS

Sports Commissioners shall use the following guidelines for the selection of all traveling
coaches.

1. Advertising must be accomplished in a manner that provides all VAA members equal
access to information on coaching vacancies and how to apply. As a minimum an article shall be
placed in one of the local newspapers, which identifies the name and phone number of a point of
contact.

2. All individuals interested in coaching a traveling team will be asked to complete an
application or submit a resume, which provides basic information about their coaching
experience. The application must be received by a predetermined date established by the Sports
Commissioner. NO INDIVIDUAL WILL BE AUTOMATICALLY ACCEPT'ED AS A
COACH BECAUSE THEY COACHED PREVIOUS YEARS.

3. The Sports Commissioner will establish a Coaches Selection Committee consisting of 3-
5 individuals. One Board member should serve on the selection committee. The Sports
Commissioner may be a member of the selection committee. THE SPORTS COMMISSIONER
MAY NOT APPLY AS OR BE SELECTED AS A HEAD COACH IN ANY SPORT WHILE
THEY ARE SERVING AS THE COMMISSIONER FOR THAT SPORT.

4. The committee will schedule an interview with all applicants. Members of the committee
shall be provided with copies of the coaches’ applications/resumes and afforded opportunity to
review them prior to interview.

5. No selections will be made until all candidates have been interviewed. The full selection
committee must then meet to discuss the interviews and make the selection as a group.

6. The Commissioner or other members of the committee are responsible for
contacting those individuals selected for the position as well as those not selected.



PP-0010 --- June 2012

APPROVAL PROCESS FOR VAA POLICIES AND
PROCEDURES

The following procedures shall be followed before ideas or suggestions become VAA official policy.
1. All members of the organization are encouraged to suggest to the Board of Directors any ideas,
which they believe, will improve the organization. The Board will review the suggestion and make a
decision as to the need if an official policy or procedure should be written.

2. When the Board decides that an official policy should be written, the idea is turned over to the
Board member responsible for maintaining policies and procedures. The board member will prepare a
draft rewrite of the policy/procedure, assign a control number and submit it to Board for approval.

3. After approval by the Board, the document will be considered an official VAA policy, placed in
the three ring binder titled VAA Plans and Policies, and added to the appropriate section of the
Association website. The binder is maintained at the VAA field house.

4. During January of each year all VAA Board members will be asked to review all plans and policies
and make suggestions for any improvements to the documents.



PP-0011 --- May 2009

Check Requests

All check requests shall be done by providing an original receipt and/or order invoice and filling
out a check request form. Upon completion of the paperwork, all requests need to be placed in
the black box attached to the VAA office door in the field house for the administrative assistant.
A check will then be cut and presented for signing to the President and Treasurer of the Board.
Once completed the check will be mailed to you or put in your VAA mailbox.



PP-0012 --- June 2005

Privacy Statement and Policy

The Valley Athletic Association (VAA) does not sell or distribute any personal information
collected by the web site. Any information collected by the web site is used only for VAA
business.

For users who have elected to join a mailing list specifically created for advertising purposes,
you may periodically receive e-mails with commercial information. These e-mails will be
distributed by VAA. Your e-mail address will not be given to the vendor.

VAA Website Media Policy

On its website VAA will publish the following information unless a parent or guardian
explicitly requests that the information not be displayed.

Pictures of children will only be displayed on the website without names. This allows team
pictures or photos from the season to be posted to the web site.

With their permission pictures of adults may be published on this website with their
names. This would allow coaches, Board members, etc. pictures to appear.

Articles about VAA events may include names of children only if a picture

identifying the child is not published on the same webpage.

Personal information, besides a name, is not permitted in the public area of the web site.
Directory type information may be published to areas of the web site that are restricted to
a small group of people. For example, team rosters may be put on the web site, provided
access to that roster is restricted to members of that team.



PP-0013 --- June 6, 2012

REGISTRATION POLICY

1. Registrations will be accepted online through the Association’s website, through the mail, or
in-person at any walk-in session offered.

2. The Commissioner of each sport will determine annually the registration schedule and any late
fees to be charged. The Board of Directors will approve these as part of the annual budget
review/approval. Coaches, Age Group Directors and Commissioners do not have the authority to
waive a late fee.

3. Late registrations of people who move into District #196 after the close of registrations will be
permitted, providing there is room available on team rosters. The Sport Commissioner must
approve all late registrations.

4. Refer also the PP-0017 Refund Policy and PP-0029 No Pay, No Play Policy



PP-0014 ---September 4, 1996

ENTERING NEW SPORTS TO THE VAA PROGRAM

l. Any individual or group wishing to enter a new sport in the VAA program must receive
prior approval from the Board of Directors. The following task must be accomplished before the
Board will meet to vote on any new sport.

a. A written request to enter the new sport must be presented to the Board of Directors a
minimum of six months prior to the start of the sport season. The request shall include the
following:

(1) Brief description of the sport.

(2) Gender, age groups and number of athletes that this program will serve.

(3) A budget.

(4) Analysis of the availability of fields, gyms, etc.

(5) Time frame for sport to be played.

(6) Analysis of any overlap with other school or VAA sports that may cause
conflicts.

2. The Board will vote to conditionally approve, disapprove or request additional
information within a two-month period and provide a written response to the requesters.

3. If the Board votes to conditionally approve, the requester will be asked to develop a
draft handbook for the sport and advertise for a Sports Commissioner. Both the handbook and
applications for Sports Commissioner must be submitted to the Board for final approval.

4. No sport will be sponsored or supported by VAA until Board of Directors has given final
approval.
5. No sport will be allowed to start a season if Board approval is not accomplished in

sufficient time to include the sport at one of the pre-scheduled sign-up dates.



PP-0015 ---April 3, 1996

PLAYERS CODE OF BEHAVIOR

All players are asked to sign the Players Code of Behavior Policy at the beginning of each
season. It is the responsibilities of the coaches to have the athletes participating on their teams
read and sign the statement as noted below.

I hereby pledge to live up to the VAA Players' Guideline by following the listed Code of Ethics:

I will do my best at all practices and during all games.
I will listen to my coaches when at practices and at games.

I will practice good sportsmanship by treating all players, coaches, parents and
officials with respect.

I will do my best to help my parents get me to games and practices on time.

I will keep my equipment and the equipment of the team in good condition by not
throwing or using it improperly.

I will play and practice the game to have fun and not be concerned about winning or
losing.

I understand that improvement comes from practice and sometimes I may decide
to practice on my own, away from scheduled practices and games.

I agree to use safety equipment when instructed to do so and pay attention to other safe
play ideas provided by coaches, players, and parents.

Player’s Signature Date



PP-0016 --- June 6, 2012

SUSPENSION OF COACHES POLICY

1. Each VAA Sports Commissioner has the authority to suspend a coach in their sport.

2. Prior to suspension, the commissioner must notify the sport liaison in writing of their intention and
submit a VAA Incident Report Form (available from the Association website).

3. If the sport liaison disagrees with the recommendation of the sport commissioner or determines
more discussion is warranted, the commissioner is required to brief the VAA Board of Directors.

This can occur electronically if the next Board meeting is not timely.

4. If a suspended coach applies for a subsequent coaching position in the VAA, the sport
commissioner must approve and/or receive approval from the VAA Board of Directors.

5. The names of all suspended and reinstated coaches will be printed in the VAA minutes.

6. The Incident Report Form will be forwarded to the Risk Manager



PP0017-—- Sept 2012

REFUND POLICY

Withdrawals must be communicated to the Sports Commissioner and the VAA Administrative
Personnel. All withdrawals should be communicated in a written format either electronically (e-mail) or
written to the Commissioner. It is the policy of VAA to grant refunds under the following circumstances:
Note: For VUSC Refunds, please refer to the VUSC Refund Policy)

FULL REFUNDS WILL BE ISSUED FOR:

e Participant tries out for a traveling team and does not make a team.

e  There are not enough participants to form full teams and excess participants cannot be added
to other rosters. Those that signed up last will be dropped.

REFUND LESS $15.00 ADMIN FEE WILL BE ISSUED FOR:

e Participant withdrawal is communicated to the commissioner prior to the formation of teams.

Late fees and tryout fees will not be refunded.

e  Participant changes sports prior to formation of teams for either sport. AMOUNT OF REFUND:
Full amount transferred to new sport, If the transferred to sport has a cost less than the
transferred from sport, the difference will be refunded less a $15 administrative fee. If the
transferred to sport has a cost greater than the transferred from sport, the participant will need to
provide payment (via check or cash) prior to formation of teams. If payment is not received,
participant will not be added.

e  VAA makes a decision to change the format of a sport and participants are given the option of
the alternative or refund (for example: if a sport does not have enough players to field a grade 9-
12 team as planned and then decided to combine grades 7-12 on a team, those affected are notified
and are given the option of playing on the 7-12 teams and they opt to not play.)

REFUNDS WILL NOT BE ISSUED FOR THE FOLLOWING CIRCUMSTANCES:
. Communication is not made to the Sports Commissioner of withdrawals.

Season has ended

The teams have been formed and Commissioner has not granted an exception. If the participant
withdrawal is communicated to the commissioner after the formation of teams the
commissioner may grant an exception based upon the rationale for the withdrawal (e.g. doctor
indicates participant can’t play.)

o AMOUNT OF REFUND: It is at the Commissioner’s discretion as to whether a refund
will be issued and what % refunded based upon cash outlay and when in the season the
withdrawal has happened. The refund (if any) will have a $15 administrative fee, late fee,
and tryout fee are deducted.

. The sport was unable to grant teammate requests. The Commissioners attempt to honor
requests but are not always able to do so. There are no guarantees that those requests will be
granted.




PP-0019 --- April 1996

PARENTS CODE OF ETHICS

All parents are asked to sign the Parents Code of Ethics at the beginning of each season. It is the
responsibilities of the coaches to have the parents of athletes participating on their teams read and
sign the statement as noted below.

I hereby pledge to live up to the VAA Parents’ Guidelines by following the listed code of ethics:

I will encourage good sportsmanship by demonstrating positive support for all players,
coaches and officials at every game, practice or other youth sports event.

I will place the emotional and physical well being of my child ahead of any personal
desire to win.

I will insist that my child play in safe and healthy environment.

I will provide support for coaches and officials working with my child to provide a
positive, enjoyable experience for all.

I will demand a drug, alcohol and tobacco-free sports environment for my child and agree
to assist by refraining from their use at all youth sports events.

I will remember that the game is for children and not for adults.
I will do my very best to make youth sports fun for my child.

I will ask my child to treat other players, coaches, fans and officials with respect
regardless of race, sex, creed or ability.

I will promise to help my child enjoy the youth sports experience within my personal
constraints by assisting with coaching, being a respectful fan, providing transportation or
whatever I am capable of doing.

Parent Signature Parent Signature Date



PP-0020 --- June 6, 2012

PROBLEM RESOLUTION GUIDELINES

These guidelines are to be followed whenever there may be concerns or questions regarding the
policies and programs of Valley Athletic Association.

1. When a player or parent has a concern regarding the policies or procedures of a sport, they should
bring those concerns to the attention of the coach.

2. If the problem persists or is unable to be resolved between the player/parent and the coach, it
should be brought to the attention of the Sports Commissioner and/or League Director.

3. At this time the Sports Commissioner or League Director shall act as a mediator between the
parent/player and coach. All parties involved will meet to discuss the situation and find a solution.

4. The Sports Commissioner or League Director shall communicate with their Board Liaison any
necessary mediation and the outcome of that mediation.

5. If necessary, the parties involved should contact the Board Liaison to help with mediating the
dispute. The Board Liaison will meet with all parties to discuss the situation and find a solution.

6. The Board Liaison will communicate with the VAA Board of Directors any situations that are
being mediated in their sport.

7. If mediation is unable to resolve the issues and all the above-mentioned steps have been followed,
the Sports Commissioner shall submit an Incident Report Form (available from the Association
website) to the Executive Committee. The Executive Committee consists of the President, Vice-
President, Treasurer, and Secretary of the VAA Board of Directors. The Sports Commissioner shall
solicit additional Incident Report Forms from all applicable parties and submit those as well. The
Executive Committee will consult with the Board Liaison on the issue. At this time the Executive
Committee may make a decision on the issue or refer the issue to the full Board of Directors.

8. The decisions of either the Executive Committee or the full Board of Directors will be final.

9. The Incident Report Forms will be forwarded to the Risk Manager and kept on file for seven (7)
years.



PP-0021 --- March 25, 1999

REPLACEMENT OF BOARD MEMBERS

1. Upon becoming a member of the Board of Directors, a member assumes certain
responsibilities. Among those is the responsibility to attend the monthly Board meetings. If a
Director misses three meetings he/she will be asked to step down.

2. When the circumstances arise that a member of the Board of Directors has resigned or
been asked to step down, the Board of Directors have the right to appoint a temporary member to
serve until the next election. At that time, the seat held by the temporary member would be

included in the general election.



PP-0022 --- March 3. 1999

REPLACEMENT OF TRAVELING PLAYERS

The following procedures shall be used to replace a player who is injured or quits any VAA
sanctioned traveling sport before the end of the season.

1. The coach of the given sport has the ultimate decision as to the need for replacing a
player who is unable or unwilling to finish a season.

2. When a coach determines that he needs to replace a player, he must notify
the Commissioner of the specific sport.

3. The Commissioner will review the tryout records and provide the names of the next three
highest ranked players who were not selected for a team. If more than one player had the same
rating, all players with that rating will be referred to the coach for selection.

4. The coach will be free to select a replacement player from the list provided to him. He
will notify the selected player and determine if they will accept an offer to fill the vacancy.

5. Once a player accepts, they will be required to complete the VAA registration form
and will be charged a fee prorated over the remainder of the season. A Coach or Sports
Commissioner cannot waive this fee.

6. If the selected player declines to fill the vacancy, the coach will continue to go down
the list until a replacement player has been found.

7. The coach will notify the Sports Commissioner of his decision and provide a
brief explanation for his choice.

8. If the Commissioner confirms to the coach that there were no players trying out who
did not make a team, the coach is free to find an eligible player who had not tried out for the
sport. This process is allowed only after all steps noted above have been taken.



PP-0023 --- June 6, 2012

NOTIFYING PLAYERS WHO TRYOUT FOR TRAVELING
TEAMS

The following procedures shall be used to notify all players who tryout to be a member on any VAA
sanctioned traveling team.

1. The applicable Sports Commissioner has the ultimate decision as to which one of the following
methods to use when notifying participants of the selection results:

a. All tryout participants will be notified in writing. Letters will be mailed through the US Postal
Service.

b. All tryout participants will be notified by telephone.
c. All tryout participants will be notified electronically by email.

d. All tryout participants will be notified using a method known as " Drive Thru". As such, a tryout
participant's parent will drive to a designated place, receive an envelope with the selection decision,
and immediately leave the area. All selected players will receive a follow up phone call from that
team's coach.

2. Regardless of the method of notification used, all players will be provided a phone number to call
if there are questions regarding the tryout process and it's outcome. Players selected for a traveling
team will also receive the name of the coach if known and the name of the team they have been
placed on. Players not selected for a traveling team will be notified that their name will be turned
over to the corresponding community sport. All funds previously paid will be transferred to the
community sport or refunded as applicable.



PP-0024 --- Sept 2012
POST-SECONDARY SCHOLARSHIP

VAA recognizes the value of community involvement that has made VAA an excellent
organization by awarding post-secondary scholarships.

A Scholarship Committee will be established every September to include no less than four (4)
active Board Members. At such time, the current sitting Board of Directors will determine how
many scholarships and the dollar amount of these scholarships to be awarded for that year.

Applications will be updated as the Board and Scholarship Committee see necessary, including
dates, etc. and to include what criteria the applicant needs to provide with the application and the
essay questions that are asked. The Administrative Assistant will submit the updated
Scholarship Application to ISD 196 high schools in October, and the Application will be posted
on the VAA website for downloading at www.vaasports.org.

Scholarship Application Procedures & Requirements:

All Applicants must be a past VAA participant and a past VAA volunteer, a graduating high
school student or in the first two years of post-secondary education, and must maintain a
minimum 3.0 GPA. Previous winners are ineligible for a scholarship. All Scholarship
Applications must be postmarked by March 31st of each year to be eligible. Any incomplete or
late applications will not be accepted.

Along with the application, applicant should provide a recent high school or college transcript
including GPA, answers to essay questions in a typed format, and a personal letter of
recommendation from a Coach, Teacher or Volunteer coordinator. Applications need to be
mailed to:

Valley Athletic Association
Attn: Scholarship Committee
PO Box 240462

Apple Valley, MN 55124

Scholarship Funds are to be used for tuition and books. VAA will present funds directly to the
recipient when proof of registration and payment is provided. Proof of registration and payment
must be submitted to VAA by February Ist of the following year.

Scholarship Committee:
After the Scholarship has closed on March 31st, the committee will receive copies of all

scholarships received for review and determination of winners. The Scholarship Committee will
utilize a point scale to independently score each applicant on predetermined criteria.



PP-0025 --- December 2. 1998

GUIDELINES FOR PROVIDING REASONABLE
ACCOMMODATIONS TO SPORTS PARTICIPANTS

GUIDELINE

Valley Athletic Association will provide reasonable accommodations to sports
participants who have special needs. Special needs are physical, mental, psychological, and
sensory disabilities that are sufficiently severe to interfere with a child's daily life. Reasonable
accommodations are actions, which can be taken that will not place an undue hardship on the
Association and its members. No accommodations will be granted which will expose any VAA
participant to an undue risk of harm.

PROCEDURE

When a child who is eligible to participate in a Valley Athletic Association activity, as
defined by its Bylaws, has special needs and seeks accommodations so that he or she can
participate in a VAA activity the following procedures will be used. It is expected that the
child's parents or guardians will participate and cooperate fully in the process:

1. A written request, including the child's name, parent's names, sport, diagnosis and its
affect on the child's ability to participate in the sport, as well as the type of accommodation
requested is presented to a member of the Board of Directors or the Sport Commissioner. No
request for accommodation will be considered if these procedures are not followed. The names
of the members of the Board of Directors and the Sports Commissioner are available from the
Valley Athletic Association.

2. Upon receipt of a written request, a committee made up of a member of the Executive
Committee, Sport Liaison, and the Sports Commissioner will meet with the child's parent(s) to
discuss the accommodation request. The discussion should include, at a minimum, the nature of
the special need, the impact of the special need on the child's ability to participate in the
particular sport, any risks involved to the child and/or others, what alternative accommodations
are possible, and what role the parents and others will play in the accommodation. Medical
documentation or a physical or mental evaluation may be required to verify the nature of the
special need and its impact on the child's ability to participate in the sport. The committee will
keep a written record of the meeting, and any agreements on accommodation will be submitted to
the child's parents and the members of the Board.

3. If no agreement is reached and the parent(s) or child wishes to pursue the matter, the
accommodation request and relevant documentation will be presented at the next regularly
scheduled Board meeting. The Board will determine what action, if any, is appropriate and will
convey that information in writing to the parent(s).



PP-0026 --- September 1, 1999

PROCEDURE TO ADD PLAYERS FOR STATE/NATIONAL
TOURNAMENT

Occasionally, it may be necessary to add players to a team in order to participate in a State/
National Tournament. These procedures should act as a guide:

l. When a team feels that there is a need to add players for an upcoming tournament, as
determined by a 2/3-majority vote, they should contact the sport Commissioner and discuss that
need.

The Commissioner will determine need based on some of the following factors:
a. An unusual number of games in a short period of time
b. A need for more specialty players (i.e. goalies, pitchers)
c. Knowledge of existing team members who are unable to participate

2. Once the decision is made that a need exists, the following procedure should be used:

a. Check with the Tournament Sponsor (MYSA, MHS, AAU, etc.) to determine if they
have rules governing a participant's eligibility.

b. Wherever possible, players from VAA should be used to fill out teams in
tournaments. Players from existing traveling teams should be utilized first.

c. Ifno player is found within VAA (or when otherwise necessary) a player from
outside VAA may be asked to participate.

(1) Any player from outside of VAA that agrees to participate in a
tournament on a VAA team needs to sign a release form (registration form).

(2) Any expenses related to allowing a new participant should be covered by
the participant and made payable to VAA.



PP-0027 --- April 30, 2000

GUIDELINES FOR OUT OF STATE TOURNAMENTS, AND
PROPER USE OF CHARERONES

1. This policy and procedure is effective for all traveling sport teams registered under the
VAA that choose to participate in any local or out of state tournaments that requires an overnight
stay.

2. There should be one "chaperone" for every two sports participants per team. A
chaperone can consist of a parent'(s) of the player(s) or any legal guardian of a sport
participant. A coach, including all assistants cannot be designated as one of the "chaperones."

A legal guardian can be defined as:

a. One who guards, protects, or defends.

b. Law- A person who is legally responsible for the care of and management of the
person or property of the one who is considered by law to be incompetent to manage his
own affairs, as a child during its minority.

3. The age groups affected are 18U, 16U, 14U, & 12U for all traveling sports registered
with the VAA.

4. It is the responsibility of the team’s head coach to make sure that this policy and
procedure is properly administered. It is the head coaches job to make sure that accommodations
for adequate number of chaperones will be in place before a decision to participate in an out of
state tournament has been made.



PP-0028 --- November 2013

SPORTS PARTICIPANT FINANCIAL ASSISTANCE POLICY

Please read this policy and procedure in its entirety.

Background

The Valley Athletic Association (VAA) seeks to provide recreational opportunities for all community and
traveling sport participants living in the ISD 196 area. This policy establishes a program which may
provide some financial assistance for need-based families.

Policy

A parent or legal guardian of a participant, who lives in the ISD 196 area and is receiving free or reduced
school lunches or can demonstrate a special hardship case, may apply for financial assistance by using
the Financial Assistance Application Form.

The price for financial assistance for community sports will be approved by the VAA Board of Directors at
the sport’s budget proposal meeting. The minimum fee will be no less than the $30 Admin fee.

Financial Assistance for Traveling Sports, Football and Lacrosse: The non-refundable fee for all
Traveling Sports, Football and Lacrosse are updated yearly before the registration opens at the
commissioner or sport director’s discretion and approved by the VAA Board of Directors. The assigned
participation fee must be paid by the applicant.

Some sports may require volunteer hours or additional fees for uniforms, tournaments, clinics, or
fundraising. Financial assistance will not cover these additional fees. All fees above and beyond the
registration fee are the responsibility of the participant.

Proof of eligibility must be submitted along with the Application Form (see Procedure below for link to
form). All information provided must be true and accurate. Failure to provide complete information may
result in denial of application. Providing false information may result in immediate suspension from all
VAA programs for every member of the participant’s family for a period of up to one year.

You must email/scan a free/reduced lunch document from the school district and a completed
financial assistance application which can be downloaded below.

Eligibility for VAA financial assistance does not guarantee that you will receive assistance.
The financial assistance fee must be paid within seven days or you will risk losing the assistance.

Applicants may request financial assistance for a maximum of one sport per participant per registration
period, for a maximum of three requests per participant per year.

All payments must be made online with a credit card. Do not send payment in the mail.

No financial assistance will be available for off-season clinics.

No refunds are given for financial assistance fees unless participant is not placed on a team.
Financial Assistance Application Forms will not be accepted during Wait List Registration period
or once registration is closed.

Financial Assistance will not be granted for registration fees already paid.



PP-0028 --- November 2013

**VAA will use reasonable care to keep all information provided

confidential.***

Procedure

Email/Scan completed Financial Assistance Application Form (download from link below) — one form per
child per sport - and proof of eligibility (qualification letter for free or reduced lunch in ISD 196)

to: admin@vaasports.org. After application is received by VAA, you will be emailed a discount code to
use when paying for registration.

If your application is accepted, we will email you a discount use when registering. You must then go
online and pay with a credit card www.vaasports.org.

***Non-payment of any fees above and beyond the VAA financial assistance may result in
participant becoming ineligible for the current and/or future sports season. If online payment is
not received by the registration deadline, there is no guarantee that a spot will be available for the
participant.***


mailto:admin@vaasports.org

PP-0029 --- Sept 2012

No Pay, No Play

The Board has decided on a "No Pay, No Play" policy. This means that there needs to be a 2-
week lull between registration and team formation. Anyone who registered and has not paid
within this 2-week lull, will not have their name placed on the final roster/registration list for
team formation.

A method for credit card payment only will be established on the website for those that have
been notified of unpaid registrations, otherwise payment can also be mailed to VAA.

If payment has been made via check and is returned as NSF to VAA. the player(s) will be
removed from the roster and/or play until payment has been received in the form of certified
funds such as cash, money order, or cashiers check.

Anyone that is registered and has not paid, but somehow ends up on the roster, the sport is
responsible for the $15.00 Administrative Fee for everyone on the roster regardless of payment
or not.



PP-0030 --- May 15, 2009

WAIVER OF REGISTRATION FEES

League commissioners may waive the registration fees for any athlete meeting the following
qualifications:

» The parent is actively managing the league as a commissioner, league board member, or
league age group coordinator during the season for which the waiver is granted.

o The waiver is noted on the registration form.
» The athlete pays all other fees required of all league participants.

» The waiver does not exceed a maximum of one waiver per family per season.

League commissioners may not waive registration fees for any athlete not meeting the above
criteria. Waivers may only be granted if the following budgetary requirements are met:

» The waivers are identified as a separate line item in budget proposals submitted to the VAA
Board

» Waivers do not exceed $50 for any one athlete.

» The budget proposal does not project a negative balance at the end of the proposal period

* The line item is approved by the VAA Board during standard budget reviews

The league will be assessed the full VAA administration fee for all athletes who receive waivers.
Note that 'financial assistance' is explicitly defined as a separate program and such grants are not
governed by this policy.



PP-0031 --- June 2013

RISK MANGEMENT POLICY

Policy Statement

The VAA recognizes the need for a comprehensive risk management program to protect the
Association and its players and members. The VAA Board will oversee the implementation to
these procedures, as well as continue the development and improvement of the organization’s
risk management program.

Responsibilities

The VAA Board is accountable for the implementation of the risk management process and
responsible for the management of risks in the business.

A board member(s) will be designated as having responsibility for the overall management of the
process, however all VAA personnel are responsible for managing risks in their areas. Specific
responsibilities of the Risk Manager are described in the document “Duties of the Risk Manager”
on the VAA website.

Sport commissioners may not assign any individual to a VAA paid or volunteer position unless
the individual has fully completed the requisite components.

All VAA and travel team activities must be overseen by a coach of record.

Applicability
This policy applies to all VAA volunteers including board members, coaches, team managers,
commissioners, directors and other volunteer positions that interact with children.

Components
The VAA Risk Management Program consists of three (3) components:

1. Background Checks — all VAA volunteers age 18 and older must undergo a background
check

1.1. A background check will be completed every three (3) years.

1.2. The check must be completed (or current) before working with players.

1.3. Sport commissioners may not assign any individual to a paid or volunteer position unless the
individual has successfully completed a background check.

1.4. Background checks will be processed only by VAA-approved agencies.

1.5. Information and instructions can be found on the vaasports.org website.

2. Concussion Training — all VAA volunteers and paid/unpaid officials (referees, umpires, etc.)
must complete the CDC concussion training.

2.1. VAA uses the CDC sponsored concussion training modules

2.2. Completed compliance certificate must be submitted to backgroundchecks@vaasports.org
2.3. Sport commissioners may not assign any individual to a paid or volunteer position unless the
individual has completed, and submitted proof of, concussion training.

2.4. Information and instructions are on the vaasports.org website



3. Accident/injury reporting —

3.1. Accidents or injuries involving VAA members and/or at VAA sanctioned practices, games
or tournaments must be reported following the Accident Reporting Procedure, found on the
vaasports.org website.

Disqualifications

A volunteer will be disqualified from VAA service for offenses including:
1. Crimes against persons, anytime in the past;

i1. Crimes of violence, within the past 20 years;

iii. Sale of illegal substances within the past 15 years.

For a volunteer in a sport commissioner or treasurer position, the following offenses will also be
considered:

1. Fraud, anytime in the past;

i1. Embezzlement or other financial crimes, anytime in the past.

Disqualification must be reported to the VAA Board President.

If any of these crimes were committed when under the age of 21, the Risk Manager and VAA
Board President may reconsider disqualification.

The Risk Manager will notify the volunteer, and their sport commissioner, of disqualification,
and that individual is prohibited from involvement with the VAA.

Confidentiality
Background check information is used only to determine eligibility to volunteer with VAA and it
will not be disclosed or distributed outside of the disqualification process noted above.

Procedures

1. List of volunteers — each sport commissioner must submit a complete list of volunteers to the
Risk Manager at riskmanagement@vaasports.org before volunteers have contact with players.
2. Completion of Concussion Training and Background Check — sport commissioners are
responsible to assure all volunteers have completed Concussion Training and Background
Check before volunteers have contact with players.

3. Tracking — The VAA Risk Manager will track compliance for all volunteers.

4. Notification — The VAA Risk Manager will notify volunteers and commissioners if
compliance is not complete and will notify the VAA President about any disqualifications.

5. History will be maintained for seven (7) years.



PP-0034 --- May 2009

BOARD APPROVALS VIA EMAIL

Budget approval: all Sports Commissioners must have a budget approved by the Board of
Directors before registration can be opened for that sport.

If a Sport Commissioner and/or the sport's Board Liaison are unable to present a budget at a
regularly scheduled meeting, the President can determine whether or not the board, via email,
can and will approve the sport’s budget.

If the President determines that approval can be done via email, the same process will pertain to
email approval as it does at the regular Board meeting.

All board members need to be emailed the budget information to be approved, including a brief
synopsis about the budget and any changes from the previous budget.

A minimum of a quorum (7) must approve the proposed budget. The Secretary will keep track
of the vote and particulars of the budget proposal. The Commissioner needs to be available to

answer any Board questions concerning the budget.

If the approval is done prior to the 15" of the month, it will be included in that month's meeting
minutes, otherwise it will be included on the following month's minutes.

All efforts will be made to present budgets at a regularly scheduled meeting.



PP-003S --- May 2009

Procedure for Annual Clean-up of VAA Website

Purpose: The VAA website requires annual cleansing of email addresses and user accounts that
are no longer required.

Email Addresses

Note: The email addresses are not simply deleted in case VAA members wish to send
information to VAA and use an old commissioner’s address. The addresses are instead sent to a
specific address that is then re-routed to the administrative assistant. Thus, the emails are
actually deleted a year later. That is why the process is to delete emails before identifying which
ones are not needed for next year.

1.

Examine the email list (email manager option on www.vaasports.org/CNC). Delete any
email address where the forwarding email is deadbox@vaasports.org.

Generate a list of email addresses in Excel. There may be a better way, but this method
at least works (I am not aware of a method of exporting a list, thought we might be able
to get one from Jeff Thiel). There are two lists that must initially be processed

separately)

a. Forwarding Aliases (addresses that go to only one forwarding address).

1.

il.

1il.

1v.

Highlight the email entries in the main section of table on the webpage.
Do a right-click and copy the highlighted text.

In a new Word document, Edit -> Paste Special -> Unformatted text

Complete a global replace ([Ctrl][H]) where Find What: = ‘Forwards To: *
(no quotes, but space before and after) and Replace With:= ‘“t” (no quotes,
no spaces). Hit [Replace All], then [Ok], then [Close].

Highlight all of the text ([Ctrl][A]) and copy ([Ctrl][C]).

In a new Excel spreadsheet, go to the top cell (A1) and paste ([Ctrl][V]).
The Word document can be deleted without saving.

b. Forwarding Alias Stacks (addresses that go to multiple forwarding addresses).

1.

ii.

1il.

Highlight the email entries toward the bottom of the table on the webpage.
Do a right-click and copy the highlighted text.

In a new Word document, Edit -> Paste Special -> Unformatted text

Complete a series of global replacements ([Ctrl][H]) . Hit [Replace All] in
each case, then [Ok], then [Close] when done.

Find What Replace With
/\w/\p /\p

/\p/\p < / />
Forwards To:"p M



http://www.vaasports.org/CNC
mailto:deadbox@vaasports.org

1v.

/\p ;

<//>; “p

Highlight all of the text ([Ctrl][A]) and copy ([Ctrl][C]).

In the same Excel spreadsheet, go to the bottom of the list already started
and paste ([Ctrl][V]) the new entries. The Word document can be deleted
without saving.

c. Complete the processing to the combined list.

1.

ii.

1il.

1v.

Highlight the text ([Ctrl][Home], then [Shift][Ctrl][End]), then Data ->
Sort -> Column A (ascending) then hit [Ok]

Delete any empty lines above email addresses. You now should have two
columns of addresses. The first is incomplete (does not have
@vaasports.org) and the second may have entries that are incomplete (too
long for display, so show ... at end).

Examine the addresses. In column C, label them as one of the following
codes:

1. A =admin, addresses that don’t change because they are always
used by the league

2. B=board; a VAA address that may change as the board changes

3. D =dead; these are addresses we know (or later determine) should
be set to deadbox@vaasports.org

4. L =league; they are league addresses that need to change as the
commissioner or other people change

5. P =personal; email addresses that are for individuals

6. T =temporary; addresses that are headed for dead, but are useful
for a short while longer. Exiting commissioners are best example.

Go to the top of the document ([Ctrl][Home]) and highlight all the data
([Shift][Ctrl][End]). Then Data -> Sort, sort by column C (ascending),
then by Column A (Ascending), then [Ok].

Go down the list and place in Column D the instructions for each address:
1. Keep = recognize it is good address
Fix = know it has to be changed

Dead = needs to be set to deadbox@vaasports.org

Temp = temporarily keep. No need to check these at this point.

A

Empty = to be determined. Leave most to all of the personal
addresses empty. Even the people we know remain in VAA; we
should check that they are getting emails, so we will check with
them too.


mailto:deadbox@vaasports.org
mailto:deadbox@vaasports.org

vi. Go to the top of the document ([Ctrl][Home]) and highlight all the data
([Shift][Ctrl][End]). Then Data -> Sort, sort by column C (ascending),
then by Column D (Ascending), then by Column A (Ascending), then
[OK].

vii. Complete the VAA address using Excel

1. Go to the top of column E (cell E1). Type the following including
the quotes, spaces, and equal sign then hit [Enter]:
=A1 & “@vaasports.org”

2. Go back to cell E1. copy the formula ([Ctrl][C])

3. Hit the down arrow. Then hit the [Shift] key and [down arrow] to
highlight multiple cells. Keep hitting the [down arrow] until all the
cells in column E are highlighted down to the last row of email
addresses.

4. Paste the formula ([Ctrl][V]) and now column E has all the full
VAA addresses.

viii. Go to the top of the spreadsheet, then click on the row number for Row 1
(which will highlight the entire row). Insert a new row by Right Click ->
Insert

ix. Label the columns: Name, Forwarding, Type, Instruction, Email
x. Save the file File -> Save...

d. Send an email to each Type = P (personal) email address asking if the person
received the email and if they still need it. The experienced Word user will
recognize that the spreadsheet is set up for a Mail Merge so the emails can be sent
out individually by the computer. Those not familiar with the Mail Merge
function will need to generate an email per person. The following is a
recommended email:

Subject: Annual VAA Email System Cleaning. Please Respond.

Dear <Name>,
VAA is completing its review of the VAA website. We are contacting each person who
has a VAA email address. You currently have the following email address active in the
VAA system:
<Email>
Please hit [Reply] to this email and let us know if

* You have use of this email address at this time and wish to leave it active

* You no longer need this email address and it can be deleted
Thanks for your help!
VAA Webmaster



e. Process the list.

1. As people respond to the email mark whether the address should be kept
or marked dead, or marked temporary

il. Process the emails as appropriate

Website User IDs

Goal is to remove user IDs that are no longer needed. In this case, however, the goal is not to
necessarily ask the person with the user ID, but the league for which that person is working.
Note: Jeff Thiel might be able to provide the same information via a behind-the-scenes data
dump.

1. Open an Excel worksheet. This might be a new file or the same file (but new worksheet)
in the file for the email project.

2. Go to the User ID Maintenance area of the VAA website:
http://www.vaasports.org/Utilities/Site_Management/VAA Management/Userids/index.p
hp

3. Select “List Users By Group”

4. Repeat the following for every league. It is not necessary to duplicate for related
privileges (e.g., don’t include groups that end with — Survey or — Admin). There are also
some misc groups

o 1ignored: Equipment:, OR_ADMIN, SM CC
o Include ProgDir:, SM_BCheck:
Highlight a group in the list and hit [List Group Members]

b. Highlight the name of the group and the top of the list and each of the entries in
the list. Copy the list (right click -> copy)

c. Go to the spreadsheet. In Column A of the first empty row, paste the list
([Ctl][VD)

d. (Optional) with the data still highlighted, goto Format -> Cells... -> Alignment
Tab and click on the box before Wrap Text until it is empty. Click [Ok] then
widen column to make viewing easy.

e. Click on the cell that contains the name of the list. Copy it ([Ctrl][C]).

f. Click in column C in the row with the first name from the list. Click and drag
down column C until each row with names in the list are highlighted in column C.
(Release the mouse button) and paste the name of the list ([Ctrl][V])

g. Delete the unneeded rows above the names. This would be the row with the list
name, the empty row, then the row with the titles (Name, UserID)

h. On the website, click on the “List Users by Group” to get the next list


http://www.vaasports.org/Utilities/Site_Management/VAA_Management/Userids/index.php
http://www.vaasports.org/Utilities/Site_Management/VAA_Management/Userids/index.php

10.

11

12.

(Optional) To clean up the league names, do a global replace to replace “Members of
group “ (do not include quotes, but do include last space) with “” (i.e., nothing). Then
select all text ([Ctrl][A]) and set the horizontal alignment to left (see formatting buttons).

Select all text ([Ctrl][A]) and sort by name (Data->Sort->Column A (ascending) then
[OKk]). This combines the different records of each individual together. Go through the
list and delete rows that don’t need to be reviewed by commissioners, including

a. People known to be active VAA board members continuing duties that need web
access

b. People known to be support staff (either VAA or website)

c. People known to be old and should be removed (be sure — can have
commissioners verify)

d. Others are left — commissioners for reference, and all the people so the
commissioners get a complete list and don’t wonder why new people are not
listed.

While going through the list (or separately afterwards) look for people who should have
the UserID cancelled

a. Any who do not have any league in their permission (excluding board members
and admin assistance). There should be few to none, but UserID without league
access is useless. Mark Delete in column D for that row.

b. Old people you know the UserID should be cancelled (e.g., old VAA board
members not cancelled last year)

Delete the user ID on the website, the delete the rows for the person in the Excel
spreadsheet.

Select all text ([Ctrl][A]) and sort by permissions (Data->Sort->Column C (ascending)
then [Ok]). Delete the rows for the permissions that must be granted to all people
(ProgDir, SiteManagement).

Look through the list for any obviously wrong entries. For instance, commissioners
should not have access to VAA Management. If anyone has improper permissions,
modify the UserID and remove the permission.

Look through the list for anything that obviously does not need verification. For
instance, leagues that only have the active commissioner listed. These can be deleted.

. Go through the list and find the commissioners. Look for their email address in the email

list, but it should be first.last@vaasports.org (or there is an error!)

Send an email to each of the commissioners. Suggested email:

Subject: Annual VAA Website UserID Cleaning. Please Respond.

Dear <Commissioner>,
VAA is completing its review of the VAA website. The people below have permission to


mailto:first.last@vaasports.org

13.

post and alter information on the <league> pages:
<List the name of each person >
Please hit [Reply] to this email and let us know:
» Should we keep or delete the permission to access your league’s website?

* Are there other individuals who should be given permission?
Thanks for your help!
VAA Webmaster

Process the responses, deleting permissions as instructed, and delete the UserID if the
user does not have permission to any league.
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Procedure for Using SurveyMonkey.com as VAA Season-End
Survey Tool

Purpose

The VAA website has an online survey option. The tool requires a VAA board member to clean

the data and prepare graphs for the commissioners. There have been issues around timeliness of

response. VAA is looking at using www.surveymonkey.com as an alternative procedure. It

contains several key attributes that fit the VAA survey program:

* An on-line survey tool that allows VAA to send links to league participants for direct on-line
survey input.

* A link can be supplied to commissioners so that they can see numeric results as graphs. This
gives instant access to data without waiting for VAA board members, but does not provide
information that identifies people supplying input.

* A download of data so VAA board member can collect all details, clean spreadsheet as
appropriate, and provide results to commissioner without.

* One account that allows generation of surveys for each league, but each survey can be
password protected and given to only the commissioner of each league.

IMPORTANT!!!

1. Surveymonkey.com can be set to allow people to return to the survey that they have
started from any computer. If the survey is set up wrong, everyone will be accessing the
same response, not providing their own! This will not be a problem if these instructions
are followed, but as a warning:

» Never use the “Email Invite” feature of the website (would be undesirable anyway!)

» Set the survey to allow multiple responses from same computer (this is included in
the instructions below and desirable anyway because of multiple athletes from one
family)

2. Itis important to follow the step on generating a custom report for the survey (it is real
easy!!!) so that confidential information is not given to the commissioner. You may or
may not need to edit the reports if any of the questions are changed after the report is
prepared.

Accessing SurveyMonkey Account

At the time of preparing this document, the surveys can be found at
www.surveymonkey.com

User ID: pres(@vaasports.org

Creating Survey
Note the section below on “Modifying Survey” may be useful if a survey is started but not
completed in one sitting.
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Finding or generating a survey:
1. Log into account and select the “My Surveys” option.

2. Determine if a survey already exists for the league. If so, there is no need to keep old
surveys, so modify the existing survey. However, there may be several reasons to have
different surveys for the same sport:

a. Different leagues (e.g., age groups) may desire separate surveys
b. Different seasons may desire separate surveys
c. League may have a mid-year and a season-end survey

3. If modifying an existing survey, review the section below (and return here when
instructed for additional details)

4. If anew survey is required, select the option “Create Survey” (option next to “My
Surveys”) and either copy an existing survey or start from scratch.

a. Be sure to include the league name in the survey name because the survey name
appears on the top of each page. The name can be changed after saving if needed.

b. There should be a default VAA survey that is used as the start of any season-end
survey to ensure uniformity.
Modifying survey questions and settings:

5. Modify the survey questions as needed. Some of the template’s questions (or questions
from prior years) will need modification/customization. For example, questions on
which age group would ideally be customized to the league so that instead of a generic
text box, the input is a multiple choice of specific selections.

IMPORTANT: The survey should include a separate page that includes only the
following questions plus any other questions that should not be provided to the
commissioner. This can be the survey introduction page.

a. (Required) Do you wish to be contacted by a VAA Board Member to discuss
these comments? (Yes/No options)

b. (Optional) Name
(Optional) Phone #
d. (Optional) Email address

e. (Descriptive Question, which is just a way of displaying text) While the VAA
Board seeks to monitor survey input, if you wish to be contacted it is suggested
that you send an email to surveys@vaasports.org. Simply request that the board
review your survey results.

6. Modify any survey options. Items that have been set before include:
a. Number the questions throughout the survey (i.e., don’t start each page with #1)
b. Upload VAA logo onto the survey



C.

NOT USED: Add a progress bar at the top of the survey (e.g., percent complete) —
the calculated % is based on pages, and is very poor.

7. When the survey appears ready, select the “collect responses” tab to prepare the Internet
link to collect input. Use the “create link” option (which we will include in email to the
league distribution list).

a. After hitting [Next >>>] you will get a link. Copy and paste that in an email to

the commissioner for testing. Do not send email yet; there is another link that is

generated in a step below.

b. The link can be retrieved at any time (instructions included in section below).

8. (Still under the “collect responses” tab) Select the “Change Settings” option (to the left).

a.
b.

C.

d.

.

f.

Set “Allow Multiple Responses™ to “Yes” (might have multiple kids)
Set “Allow Responses to be Edited?” to “Yes”

Set “Display a "Thank You" Page?” to “Yes” then add text.

Set “Survey Completion” to “Loop to start” or “Close”

Set “Save [P Address in Results?”” to “No” (so we do not give ID information to
commissioners)

Click on [Save Settings]

9. (Still under the “collect responses” tab) Select the “Change Restrictions” option (to the

left).

a.
b.

C.

Set a cutoff date.
Do NOT use any of the other options

Click on [Save Restrictions]

Preparing report for commissioner:

It is important that a report is prepared for the commissioner to protect confidential information.
If the commissioner is sent a link to the “Default Report,” then s/he will have access to the
names and phone numbers!

10. If you are not sure whether the survey will collect IP addresses, go to the “collect
responses” tab, click on [Change settings] and make sure the option to collect IP
addresses is set to “No” (save settings if needed)

11. Go to the “analyze results” tab. Look at the “current report” field above the top of the
report. A new report will have “Default Report.” An existing report may have
something else.

a.

Click on the down arrow next to the report name to see the full list of reports.
You are looking for a report with the name “Hide Contact Info — [league name]”.

i. If the report name exists, select the name and then click on [Edit Report].

ii. If the report name does not exist, click on [Add Report] then enter the
correct name in the “Name” field at the top of the new report.



b. Unclick the box in front of the page that contains the confidential information,
then click on [Save Report >>]

12. (still under the “analyze results” tab) Click on “Share Responses.”

a. IMPORTANT - this step must be first because the other steps are specific to
each report! In the “current report” field, select the report for this league (“Hide
Contact Info — [league name]”).

b. Select “Share Summary of Responses + View and Browse Individual Responses
(admin view).” Make sure the two boxes (allow filtering and allow downloading)
are checked.

c. (Ifnot already checked...) Click on “Password Protect Shared Responses” so that
it is checked (may need to wait for the screen to complete an automatic update
after selecting the above option.)

d. Input a password. Change the password if one already exists from last year)
e. Click on [Save Password Changes]

f. Copy the link under “Sharing Status” and the password to the email to the
commissioner. Explain these may be used to view and download both summaries
of the results and actual surveys without confidential information.

Verify the survey and report links are prepared and correct

13. Use the link that should be sent to families to open a survey and complete a survey to
ensure the link is correct and all questions response appropriately.

a. Be sure to input information into any confidential questions!

14. Use the link that should be sent to commissioner to view results. Click on [Browse
Responses >>] and make sure that

a. The IP address at the top of the survey is blank
b. The confidential information does not appear

c. All other questions, including the league-specific questions, do appear

Ask commissioner to verify survey is ready

15. When complete send the email with the links for the survey to the commissioner and
request verification that the survey is correct. Emphasize that the links should not be
shared with anyone! Ask for any questions that can be customized (e.g., split into specific
age groups) and if there are additional league-specific questions to add.

a. Note that the survey must be open for the commissioner to use the link. “Open”
is the default, but see section on “Opening Survey” below if needed.

b. Adjust the survey as needed based on feedback. The report may need to be
changed if questions are changed.



16. (Optional) When survey is prepared, close the survey until the league is ready to collect
input (see section on “Opening Survey”, but click on the word “Close” in the status
column).

Opening survey to families
1. Log into account and select the “My Surveys” option.
2. Click on the name of the survey to open.
3. Click on the “collect responses” tab.
4

If the Status column says “Open,” then the survey is already open. Otherwise, click on
“Close”, then “Open Collector Now” on the next screen.

5. Examine the column “# of responses.” If the number is >0, then

a. If'there is a reason for saving the responses, see section on “Exporting
Responses.”

b. Click on the image of an eraser in the “Clear” column to remove old or test
responses.

6. Check the closing date is correct: On the “collect responses” tab click on the name in the
“Collector Name (Method)” column, then on “change restrictions.” Correct if needed
and click on [Save Restrictions]

Emailing links to people responsible for advertising survey

The following is a collection of emails that should be sent to various people. The email to the
commissioner is redundant to the information sent during testing. However, sending these
separately as part of the procedure ensures the commissioner does not send the wrong link to the
families. These emails also contain more information and instructions than the testing email.

In all cases, log onto the www.surveymonkey.com account and click on “My Surveys” then on
the name of the survey of interest

1. Announcement to newsletter: Go to the “collect responses” tab and if necessary click on
the name of the collector. Click on “Get Survey Link” and copy the link under “Sending
Survey Link in an Email?” to a new email message. Address the email to the editor of
the VAA Happenings... newsletter. Identify the league and request an announcement be
included in the next Happenings... newsletter.

2. Announcement to families: Send a copy of the above link to the commissioner. Copy the
VAA board member responsible for maintaining the VAA website. Remind the
commissioner that the survey is open and to

a. Add an announcement to the league homepage stating the survey is open. Inform
the commissioner the text of the announcement should end with the following
information (copy the link into the position indicated)

[link-window,place link to survey between commas, Link to on-line survey.|

b. Send an email to the league-specific email distribution list requesting people
participate in the survey. The email should include a copy of the link.
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3. Announcement to commissioner: This is sent separately to minimize the chances the
commissioner sends the wrong results. Send the email to the commissioner and copy the
VAA board member who is the league liaison.

Go to the “analyze results” tab and click on “Share Responses.”

b. Click on the down arrow next to the report name to see the full list of reports.
You are looking for a report with the name “Hide Contact Info — [league name]”.

c. Confirm the report has correct “Sharing Status” and is password protected
(remember to click on [Save Password Changes] if password is added/changed).

d. Copy the link under “Sharing Status” and the password to an email to the
commissioner. Explain these may be used to view and download results and that
the links should not be shared!

Monitoring and viewing survey results
There are two primary methods of viewing results:

1. Use the links sent to the commissioner to view the summaries without confidential
information

2. Log onto the account, click on “My Surveys” then for the correct survey click on the
image in the column “Analyze”. Go to the field “current report” and set to “Default
Report” so you see confidential information. You can now select the results desired (e.g.,
[View Summary] or [Browse Responses]).

3. Glance at the summary view for the head coach. If there are surveys giving low ratings,
give a look at the surveys and consider if there is any input that should be communicated
to the VAA board member responsible for monitoring member behavior issues.

The VAA board member responsible for surveys will need to periodically (e.g., at a minimum
before each VAA board meeting) review the results for any open surveys to determine if there
are any surveys where the family requested contact from VAA to address issues.

Sharing info to address issues

If an individual wishes to have issues in a survey discussed with a VAA board member, the best
method may be to export the data for the survey to Excel (.xls), delete all but the one row for the
survey of interest, and to email the Excel file to the liaison for the respective league.

Exporting and Storing Survey Results

Exported results including the confidential information must be guarded. Data are downloaded
to store for future reference or to supply individual records to league liaisons. Data can be
downloaded by the commissioners, so there is no need to provide this service!

1. Log into account and select the “My Surveys” option. For the correct survey, click on the
image in the “Analyze” column.

2. Click on [Download Responses]. In the field “current report”, select the correct report
that will provide the desired information.

3. Set the download options. “Spreadsheet Format” will give a readable Excel file.



Modifving Existing Survey

1. Log into account and select the “My Surveys” option.
2. Click on the title of the survey to open it in editing mode.
a. The “Design Survey” tab should be the same as when editing from scratch

b. The “Collect Responses” tab probably gives you a table. Click on the “Collector
Name (Method)” link to check/set survey options and restrictions.

3. Edit the survey as described above. Be sure to follow all steps to make sure the survey is
correctly set up for this year.

Deleting Existing Survey
The survey can not be open when it is deleted.

1. Log into account, select the “My Surveys” option, and click on the image in the “collect”
column for the survey to be deleted.

2. If the status says “Open”, click on “Open” then [Stop Collecting Now]. Click on “My
Surveys” to return to the listing of surveys.

3. For the survey to be deleted, click on the image in the “Delete” column then [Yes, Delete
Survey].

Viewing Report Passwords
The passwords are visible from the website. Navigate to the password (home -> My Surveys ->

Click on survey name -> analyze results -> share responses -> select report title in ‘current report
field”) and it will be visible.
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